
New Horizon Map (File Menu)

Create a new horizon map window, using the stored default settings. If the "auto redraw" 
option is turned on, the map will be computed and displayed automatically as soon as the 
window has been created.



New Area Map (File Menu)
Selecting this option displays the Area Map View dialog.
Press the OK button to create a new area map using the specified centre position and field 
of view.
Press the Cancel button to cancel the operation.



Open (File Menu)

Open a saved map file. When this option is selected a standard file selector will be 
displayed, allowing you to select the name of a map file to be opened.
Press OK to open the map file as a new map window.
Press Cancel to abort the operation.



Close (File Menu)

Close the current window.



Save (File Menu)

Save the current map using the existing file name.



Save Defaults (File Menu)

Save the current map settings as the default values to be used for creating a new map of 
this type. You will be asked to confirm that the settings should be saved.



Save As (File Menu)

Save the current map to a file, prompting for a file name. Selecting this option will display a
standard file selector, allowing you to enter the name under which the map should be 
saved on disk.
Press OK to save the map file to disk.
Press Cancel to abort the operation.



Preferences (File Menu)

Display the Global Preferences Dialog, to set up global program options.



Write BMP File    (File Menu)

Save the current map as a picture to a Windows bitmap (BMP) file, prompting for a file 
name. Selecting this option will display a standard file selector, allowing you to enter the 
name under which the map should be saved on disk.
Press OK to save the map file to disk.
Press Cancel to abort the operation.



Zoom In (View Menu)

Zoom in on the map. The map is zoomed around the centre of the image currently visible in
the window.



Zoom Out (View Menu)

Zoom out on the map. The map is zoomed around the centre of the image currently visible 
in the window.



Zoom to 10° Field of View (View Menu)

Zoom to a 10° (vertical) field of view.



Zoom to 20° Field of View (View Menu)

Zoom to a 20° (vertical) field of view.



Zoom to 60° Field of View (View Menu)

Zoom to a 60° (vertical) field of view.



Zoom to 90° Field of View (View Menu)

Zoom to a 90° (vertical) field of view.



Zoom to 180° Field of View (View Menu)

Zoom to a 180° (vertical) field of view. This displays the whole of the visible sky on a 
circular map.



Show (View Menu)

Display the Visible Objects Dialog. This dialog provides a rapid means of controlling the 
visibility of the different types of object which can be displayed on the map.



Time Skip (View Menu)

Switch "time skip" mode on or off. When switched on, the map time will be updated 
automatically at the interval set by the Automatic Map Update Dialog, which is accessed 
from the Time Skip... option of the Options menu.



Copy (View Menu)

Copy the current window as a bitmap image to the Windows clipboard. Once copied, it can 
be pasted into other applications, such as a word processor.

Notes:
This function copies the entire "client area" of the window, and will only work successfully if
the window is wholly visible on the screen. Using this function when the window is partially 
off the edge of the screen will result in "garbage" being written to the portion of the bitmap
corresponding to the non-visible portion of the window.



Select North View

Set the map view to North, preserving the current altitude and field of view.



Select East View

Set the map view to East, preserving the current altitude and field of view.



Select South View

Set the map view to South, preserving the current altitude and field of view.



Select West View

Set the map view to West, preserving the current altitude and field of view.



Increase Limiting Star Magnitude

Increase the limiting magnitude of the stars on the map by half a magnitude.



Decrease Limiting Star Magnitude

Decrease the limiting magnitude of the stars on the map by half a magnitude.



Toggle Star Label Display

Switch the display of star labels on or off. Star labels are displayed according to the 
settings in the Star Labelling Options dialog.



Toggle Constellation Figure Display

Switch the display of constellation figures on or off. Constellation figures are lines 
connecting the bright stars in a constellation, and can provide a useful way of memorising 
the constellations.



Toggle Constellation Name Display

Switch the display of constellation names on or off.



Toggle Constellation Boundary Display

Switch the display of official IAU constellation boundary lines on or off.



Toggle Comet Display

Switch the display of comets on or off. The comets to be displayed are selected using the 
Comet... item on the Options menu.



Toggle Asteroid Display

Switch the display of asteroids on or off. The asteroids to be displayed are selected using 
the Asteroid... item on the Options menu.



Toggle Deep-Sky Object Display

Switch the display of deep sky objects on or off. The type of deep sky objects to be 
displayed are selected using the Deep Sky... item on the Options menu.



Toggle Altitude/Azimuth Grid Display

Switch the altitude/azimuth grid on or off. The way the grid is displayed is controlled using 
the Alt/Az Labels... item on the Options menu.



Toggle Right Ascension/Declination Grid Display

Switch the RA/Dec grid on or off.



Draw Map (View Menu)

If automatic redraw mode is turned off, this option causes an invalid map to be recalculated
using the current settings. The symbol "INV" (Invalid) will be displayed on the status bar 
when the map needs recalculating.

See also:
Auto Redraw



Flip Map Vertically (View Menu)

Invert the map top-to-bottom. This command can be used to correctly align the map 
display with the inversions and reflections of the image introduced by the optics of your 
telescope.



Flip Map Horizontally (View Menu)

Reflect the map left-to-right. This command can be used to correctly align the map display 
with the inversions and reflections of the image introduced by the optics of your telescope.



Clean Up Map (View Menu)

Remove any eyepiece circles, Telrad finder circles, and object tracks from the map.



Set Map Viewpoint (Options Menu)

Set up the viewpoint of the map. Selecting this option displays the Field of View dialog.



Stars (Options Menu)

Display the Stars Dialog. This determines the magnitude of the faintest star which will 
appear on the map, and also controls the size of the star images.



Star Labels (Options Menu)

Display the star labels dialog. This controls which stars on the map will be labelled (if star 
labels are turned on), and also what type of label (proper name, Bayer letter, or Flamsteed 
number) a star is labelled with.



Deep Sky Options (Options Menu)

Display the Deep Sky Options Dialog. This controls what type of deep sky objects will be 
displayed on the map (if deep sky object display is turned on).



Comets (Options Menu)

Display the Comet Selection Dialog. This determines which comets in the comet catalogue 
are displayed on the map, and also provides maintenance facilities for the catalogue, 
allowing the user to add, remove and edit comet details.



Asteroids (Options Menu)

Display the Asteroid Selection Dialog. This determines which asteroids in the asteroid 
catalogue are displayed on the map, and also provides maintenance facilities for the 
catalogue, allowing the user to add, remove and edit asteroid details.



Alt/Az Grid (Options Menu)

Display the Altitude/Azimuth Label Options Dialog. This determines the way in which the 
altitude and azimuth scales of the Horizon map are labelled.



RA/Dec Grid (Options Menu)

Display the RA/Dec Grid Options Dialog. This determines the way in which the right 
ascension/declination grid is drawn on the Horizon map..



Screen Colours (Options Menu)

Displays the screen colour editing dialog. This allows the user to edit the colour of the 
various objects appearing on the screen map display. These colour settings are 
automatically saved between runs of the program.



Printer Colours (Options Menu)
Displays the printer colour editing dialog. This allows the user to edit the colour of the 
various objects appearing on a colour printed map. These colour settings are automatically 
saved between runs of the program.



Screen Fonts (Options Menu)

Displays the screen font editing dialog. This allows the user to select the font used to draw 
the various items of text which appear on the screen map display. These font settings are 
automatically saved between runs of the program.



Printer Fonts (Options Menu)

Displays the printer font editing dialog. This allows the user to select the font used to draw 
the various items of text which appear on the printed map. These font settings are 
automatically saved between runs of the program.



High Precision (Options Menu)

Switches high precision calculation mode on or off. When high precision mode is switched 
on (ie, when a check mark appears alongside the menu), the positions of all objects 
displayed on the map are rigorously corrected for precession, proper motion (in the case of 
stars), aberration, nutation, and refraction. When high precision mode is switched off, 
positions are only corrected for refraction.

The only situation in which high precision mode becomes important is when displaying 
maps for the distant past or future, where precession has an important influence. As a 
rough guide, high precision mode should be switched on for any map drawn for a date 
more than 50 years either side of 2000AD.



Astrometric (Options Menu)

Toggles astrometric drawing mode on or off.
When astrometric drawing mode is switched off, the positions of all objects displayed on 
the map are rigorously calculated for the epoch of observation. Star positions are corrected 
for precession, proper motion, nutation and aberration. Switch off astrometric mode if you 
want to see the coordinates of objects as they actually are in the sky for the date and time 
at which you are observing.
When astrometric drawing mode is switched on, the stars are displayed on the map in their
J2000.0 catalog positions, and all other objects are precessed to this standard epoch. The 
only position correction applied to the positions of stars is proper motion. On this type of 
map, all moving objects will be shown in the correct place relative to nearby stars, but their
right ascension and declination will be for epoch J2000.0, rather than for the epoch of 
observation.
The program can calculate astrometric maps much more quickly than non-astrometric 
maps. This option is initially switched on as a default, and should probably be left switched 
on.



Auto Redraw (Options Menu)

Switches "auto redraw" mode on or off. When switched on (ie, when a check mark appears 
alongside the menu item), the map is automatically recalculated following any change 
which necessitates this. If you are running SkyMap on a slow computer - specifically, on a 
computer without a maths co-processor - you may wish to switch this option off to allow 
you to make changes to the map settings more rapidly.

If auto redraw mode is switched off and the map settings change in a way that necessitates
a recalculation, the letters "INV" (short for "Invalid") will appear on the status bar to inform 
you of the situation. Once all required changes have been made, the map can then be 
recalculated using the Draw item on the View menu, or the equivalent tool bar button or 
keyboard shortcut.



Time Skip (Options Menu)

Displays the Automatic Map Update Dialog, which controls the rate at which map time 
automatically advances when time skip mode is switched on.



Search for a Planet (Search Menu)

Search for a planet, or the Sun or Moon. A dialog box containing the names of the planets 
will be displayed. The action of this command varies slightly with the map type:

On an Area map, the map will be centred on the location of the planet.

On a Horizon map, the map will be centred on the location of the planet if it is currently 
above the horizon using the current location and time settings. If the planet is not currently
visible, a message will be displayed and the current viewpoint left unchanged.



Search for a Constellation (Search Menu)

Search for a constellation. A dialog box containing the names of the constellations will be 
displayed. The action of this command varies slightly with the map type:

On an Area map, the map will be centred on the location of the constellation name.

On a Horizon map, the map will be centred on the location of the constellation name if it is 
currently above the horizon using the current location and time settings. If the constellation
name is not currently visible, a message will be displayed and the current viewpoint left 
unchanged.



Search for a Star by Proper Name (Search Menu)

Search for a star by specifying its "proper name". A proper name is a name such as 
"Polaris", "Betelgeuse", "Aldebaran", etc. Only a few stars on the map will have a proper 
name; mainly the brighter stars.

On a Horizon map, this command will display a dialog box listing all the proper names of 
stars that are currently above the horizon. Selecting a name will centre the map on that 
star.

On an Area map, the command displays a dialog box listing all the proper names in the star
database. Selecting a name will centre the map on that star.



Search for a Star by Bayer Letter (Search Menu)

Search for a star by specifying its Bayer letter. Bayer letters are Greek letters which label 
the brightest stars in a constellation. In the majority of cases, the stars are labelled roughly 
in decreasing order of brightness; the brightest star being "a", the second brightest "b", 
and so on, although there are exceptions to this. The stars of Ursa Major, for example, are 
labelled in sequence along the shape of the "Plough" or "Big Dipper". In some cases, a 
number is added to the letter. The stars forming Orion's "shield", for example, are labelled 
"p1", "p2", etc.

When this command is selected, a dialog box is displayed allowing the entry of a Greek 
letter, a qualifying number, and a constellation. The number zero should always be used 
where no number is required.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Star by Flamsteed Number (Search Menu)

Search for a star by specifying its Flamsteed number. Flamsteed numbers are numbers 
which label the brighter stars in each constellation. Today they are normally used in cases 
where a fairly star does not have a Bayer letter, since they normally extend to a fainter 
magnitude limit than that permitted by the 24 letters of the Greek alphabet used in the 
Bayer labelling scheme.

When this command is selected, a dialog box is displayed allowing the entry of a Flamsteed
number and a constellation.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Star by SAO Catalogue Number (Search Menu)

Search for a star by specifying its SAO catalogue number. This is rarely useful, but is 
supplied for completeness. When this command is selected, a dialog appears allowing the 
entry of an SAO catalogue number.

In the case of a Horizon map, the stars currently above the horizon are searched for a 
match with the specified star. In the case of an Area map, the entire star database is 
searched. If a match is found, the map is centred on the star; otherwise a message is 
displayed.



Search for a Deep Sky Object by Popular Name (Search Menu)

Search for a deep sky object by its "popular name". Such names include "Orion Nebula", 
"Whirlpool Galaxy", "Ring Nebula", etc.

Selecting this option displays a dialog box of names. In the case of a Horizon map, the list 
contains the names of all objects currently above the horizon; in the case of an Area map, it
contains all the names in the database. Selecting a name centres the map on the location 
of the object.

Note that the object will not necessarily be visible on the map after this command is used. 
The command simply centres the map on the location of the object - it does not 
automatically display it. You may have to use the Deep Sky... item on the Options menu, 
and possibly the Deep Sky tool bar button to actually see the object!



Search for a Deep Sky Object by Catalog Number (Search Menu)

Search for an object in the deep sky database by catalog number. When selected, a dialog 
will appear in which a catalogue number (such as "M 31" or "NGC 7088") can be entered. In
the case of a Horizon map, the list of objects currently above the horizon will be searched 
for the object; in the case of an Area map, the entire database will be searched. If located, 
the map will be centred on the location of the object.

Notes:

1. The object will not necessarily be visible on the map after this command is used. The 
command simply centres the map on the location of the object - it does not 
automatically display it. You may have to use the Deep Sky... item on the Options 
menu, and possibly the Deep Sky tool bar button to actually see the object!

2. The catalog number entered is not case sensitive, and spaces are not significant 
(although all other characters, such as "-", are significant). Thus, if you wish to search
for "NGC 4565", you may enter any of the following:
NGC 4565
nGC4565
ngc4 5 65
and the object will still be located.

3. You may search for either the "main" or the "alternative" name of an object. For 
example, entering either "M 42" or "NGC 1976" will successfully locate the Orion 
Nebula.



Search for a Comet (Search Menu)

Search for a comet on the map. When this command is selected, a dialog box with a list of 
comets will be displayed. In the case of an Area map, the list will contain the names of all 
the currently active comets; for a Horizon map it will contain those active comets which are
currently above the horizon.

Selecting a name from the list will centre the map on the comet's location.



Search for an Asteroid (Search Menu)

Search for an asteroid on the map. When this command is selected, a dialog box with a list 
of asteroids will be displayed. In the case of an Area map, the list will contain the names of 
all the currently active asteroids; for a Horizon map it will contain those active asteroids 
which are currently above the horizon.

Selecting a name from the list will centre the map on the asteroid's location.



Setting the Date and Time of Observation (Options Menu)

To set the time and date for which the map is drawn, select the Time... item from the 
Options menu. The Observation Time Dialog will be displayed.
For the horizon map, changing the time of observation obviously alters the map view 
completely. For the area map, the main effect is to alter the positions of objects in the solar 
system.

Shortcut:        

Notes:

1. The observation time is taken to be in the observer's local time zone. SkyMap 
converts the entered time to UTC by applying the corrections for the observer's time 
zone and (if applicable) for daylight saving time.

2. If the date is on or after 0h on October 15th, 1582, it is assumed to be in the 
Gregorian calendar. If before this, the Julian calendar is used.



Setting the Location of the Observer (Options Menu)

To set up the position of the observer, together with associated information such as time 
zone information, weather conditions, etc, select the Observer... item from the Options 
menu. The Observation Location Dialog will be displayed.
For the horizon map, changing the observer's location obviously alters the map view 
completely. For the area map, the only effect is to slightly alter the apparent positions of 
objects in the solar system, most notably the Moon, due to the effects of parallax.

Shortcut:        



Image Viewer (Tools Menu)

Run the Image Viewer application. By default this is the SkyImage program supplied with 
SkyMap, but can be customised to run any program by changing the "Viewer" entry in the 
Global Preferences Dialog.



Planet Visibility (Tools Menu)

Displays the Planet Visibility Dialog, which provides a quick way of seeing which solar 
system objects are currently above the horizon.



Daily Phenomena (Tools Menu)

Displays the Daily Phenomena Dialog, showing the rise, set and transit times of the Sun, 
Moon and planets. Note that this can take a short time to calculate, especially on a slow 
computer.



Eyepiece Database (Tools Menu)

Displays the Eyepieces Dialog, which displays the eyepiece and telescope databases, 
allowing the magnification and field of view of any combination of eyepiece and telescope 
to be determined.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
maps that you viewed.



Exit (File Menu)

Use this command to end your SkyMap session.    You can also use the Close command on 
the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in SkyMap.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in SkyMap,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

To obtain information about any button on the Toolbar, select context sensitive help mode 
by either clicking the help button:

or pressing SHIFT+F1, then click the button you require help on.



Status Bar (View Menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state.
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the SkyMap window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade (Window Menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile (Window Menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal (Window Menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical (Window Menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window Menu)

SkyMap displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    
Choose a document from this list to make its window active.    



Help Index (Help Menu)

Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using SkyMap and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help (Help Menu)

Use this command for instructions about using Help.



About SkyMap (Help Menu)

Use this command to display the copyright notice and version number of your copy of 
SkyMap.



Map Status (Help Menu)

Display the Map Information Dialog, showing information about the current map.



Registration Benefits (Help Menu)

Selecting this option displays the Registration Benefits Dialog, explaining the benefits of 
registering the unregistered version of SkyMap. It also displays the length of time that the 
program has been in use for.



Context Help 

Use the Context Help command to obtain help on some portion of SkyMap.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the SkyMap window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Scroll Bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size (System Menu)

Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move (Control Menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize (Application Control Menu)

Use this command to reduce the SkyMap window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize (System Menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window (Document Control Menu)

Use this command to switch to the next open document window.    SkyMap determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window (Document Control Menu)

Use this command to switch to the previous open document window.    SkyMap determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close (Control Menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the SkyMap window



Restore (Control Menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to (Application Control Menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Print (File Menu)

Print the current map to the default printer. Selecting the option displays the Print Options 
Dialog, allowing the print options to be selected.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Dialog

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that SkyMap is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup (File Menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup Dialog

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



The Horizon Map

A horizon map shows a view of the sky as seen by an observer for a selected place and 
time. Its main use is simply to see "what's up" at any desired time. Once the map has been 
calculated, the viewpoint can quickly be moved to display a view of any part of the visible 
sky.
Although all the information in SkyMap's databases can be displayed on a horizon map, it 
isn't a good idea to display faint stars, deep-sky objects, etc - the map just gets too 
crowded and takes too long to draw! The recommended way of working is to use the 
horizon map to get a general picture of what's visible, then to draw a detailed Area map for
a specific part of the sky that you wish to observe.
For more information about drawing and using a horizon map, select one of the topics 
below:

Creating and Setting up a Horizon Map
Changing the Viewpoint
Displaying Objects on a Map
Identifying Objects on a Map
Measuring Angular Separation
Searching for Objects on a Map
Drawing an Area Map
Saving the Map Settings

See also:
Using the Help System



Identifying Objects on a Map

To identify any object on a map:

1. Position the tip of the mouse pointer over the object, then press the right mouse 
button. A "pop-up" menu will appear underneath the mouse pointer. The exact 
number and wording of the items on the menu will depend on the situation, but there
should be a menu item referring to the object you clicked on.

2. Select the item with the left mouse button, and a dialog box containing information 
about the object will be displayed.

For further help on the information displayed in the object description dialog box, press F1 
while the dialog is visible.



Drawing an Area Map from a Horizon Map

There are three different methods of drawing an Area Map from a Horizon Map display:

1. Select the File/New Area Map... menu item.
2. Position the mouse pointer over the point on a Horizon Map that you want to appear 

in the centre of the area map. Press the right mouse button to display the pop-up 
menu of local options. Select the Area Map... item from this menu.

3. Hold down the left mouse button and "drag" a selection rectangle around the portion 
of the Horizon Map for which you want to draw an Area Map. Release the left mouse 
button when the selection rectangle is the correct size. This method is better in most 
cases than method (2) since it allows the size, as well as the centre, of the map to be 
selected graphically.

Whichever of these methods is used, the Area Map View Dialog will be displayed. Conform 
that all the information displayed, then press OK to display the new map, or Cancel to 
cancel the operation.



Changing the Horizon Map Viewpoint

Once the horizon map has been displayed for the first time, the viewpoint can easily be 
changed to view any part of the visible sky. There are several ways to do this:

1. Use the buttons on the tool bar to change the view to North, East, South, or West. 
This leaves the central altitude and field of view unchanged.

2. Position the mouse pointer over the location you wish to be the centre of the new 
map. Press the right mouse button. Select Centre from the pop-up menu which appears.

3. From the Options menu select Field of View. Enter the central altitude and azimuth
and the required field of view into the dialog box which appears.

Shortcut:        



Creating and Setting Up a Horizon Map

To create a new horizon map, select New Horizon Map from the File menu. A new map 
window will appear, and the default map settings will be loaded. The time and date will be 
read from the computer's clock. Once the map has been created, you will probably wish to 
configure it. This involves several steps:

Setting the Date and Time of Observation 
Setting the Location of the Observer
See also:
Saving the Map Settings



Displaying Objects on the Horizon Map

A wide variety of objects can be displayed on a horizon map. These include:

Stars
Planets
Comets
Asteroids
Deep sky objects (galaxies, star clusters, and nebulae)
Constellation boundaries, figures, and names
A grid of altitude and azimuth lines

The objects which appear on the map are controlled in two ways:

1. The items on the Options menu set the display options for each type of object. For 
example, the Star Labels... item controls the way in which stars are labelled; the 
Comets... item allows the user to select which comets will be displayed. To get 
specific help on these options, select the item and then press F1.

2. The Show... item on the View menu (and the equivalent buttons on the tool bar) 
allows the user to select which items are shown on the map. A huge quantity of 
information is available, and having it all displayed at once would be very confusing. 
This menu item provides a rapid way to select exactly the desired items.

Shortcut:        



Saving the Horizon Map Settings

When all the horizon map options have been set up to your satisfaction they can be saved 
for use as the default settings for all subsequent horizon maps. To do this:

1. From the File menu select Save Defaults.... A dialog box will appear asking for 
confirmation of the operation.

2. Click on the Yes button, or just press Enter. The current map settings will then be 
saved.



Searching for Objects on a Horizon Map

To search for specific objects on a horizon map use the items on the Search menu. Note 
that you can only search for objects which are currently above the horizon.

See also:
Searching for a Planet
Searching for a Constellation
Searching for a Star by Proper Name
Searching for a Star by Bayer Letter
Searching for a Star by Flamsteed Number
Searching for a Star by SAO Number
Searching for a Deep Sky Object by Popular Name
Searching for a Deep Sky Object by Catalog Number
Searching for a Comet
Searching for an Asteroid



Observation Location Dialog

This dialog contains information about the observer. The information can be divided into 
several categories:

Position Information
The latitude and longitude of the observer, in degrees, minutes and seconds. This 
information can be obtained from a local map.

Time Zone Information
The observer's time zone, and whether or not daylight saving time is currently in effect. 
Note that the time information is entered in minutes (not hours) ahead of or behind UT 
(Greenwich Mean Time).

Weather Information
The observer's local weather conditions. This information is used to calculate the effects of 
refraction. Unless you live in a very extreme climate, or desire the ultimate in accuracy 
when calculating the apparent altitude of an object, it is quite acceptable to leave these 
values at their default settings.

Location List
The listbox at the bottom of the dialog can be used to select a location. If a name is 
selected from a list, the appropriate latitude, longitude and time zone information are 
automatically filled in.
You can add your own entries to the location list by editing the ASCII file LOCATION.SKY with
any convenient editor - the DOS "edit" editor is fine for this purpose. Each line in the file 
consists of four items, separated with a space. These items are, in order:

Latitude in degrees, + if North, - if South.
Longitude in degrees, + if West, - if East.
Time difference from GMT in hours. + if behind GMT, - if ahead of GMT
Name to appear in the list.

An example line from the file is:
47.60 122.33 8 USA: Seattle WA

If you add the names of any large towns or cities to the list, please send me the information
and I'll incorporate it into the next release of SkyMap.



Observation Time Dialog

This dialog specifies the date and time of observation. Note that the time is taken to be in 
the observer's local time zone, possibly corrected for the effect of daylight saving time, as 
specified in the Observation Location Dialog.

The Now button sets the date and time from the computer's clock.
The Midnight button leaves the date unchanged, but sets the time to 00:00:00.

Note that any date on or after October 15th, 1582, is assumed to be in the Gregorian 
calendar. Any date before this uses the Julian calendar.



Horizon Map View Dialog

This dialog defines the centre and field of view of the horizon map.

Map Centre
The altitude and azimuth of the centre of the map.
Field of View
The vertical field of view of the map. in degrees.



About SkyMap Dialog

This dialog displays copyright and version information about SkyMap. When requesting 
help, please always quote the version number shown. The picture is the spiral galaxy M74 
in Pisces.



Star Dialog

This dialog controls both the "limiting magnitude" of stars on the map (ie, the faintest star 
which is drawn), and also the way in which the stars are drawn.

Limiting Magnitude
The magnitude of the faintest star to be drawn on the map.

Image Display
This section of the dialog allows you to control the sizes of the "dots" used to represent the 
stars on the map.
The first line shows the size of the largest star image which will be drawn, and the 
magnitude it corresponds to. Any star brighter than the magnitude shown will be displayed 
using this dot size.
The second line shows the size of the smallest star image which will be drawn, and the 
magnitude it corresponds to. Any star fainter than the magnitude shown will be displayed 
using this dot size. Note that if automatic magnitude scaling is switched on (see below), the
number entered on this line is ignored.
A star whose magnitude falls between these two limits (as the majority should do) will be 
drawn with a dot whose diameter is inversely proportional to the magnitude.

Automatic Magnitude Scale
This checkbox switches between "manual" and "automatic" magnitude scaling.
If "manual scaling" is in operation (the only option available in previous versions of the 
program), the "faintest star" symbol is used for any star fainter than the magnitude entered
in the second line of the "Image Display" section of the dialog.
If "automatic scaling" is in operation, only the size of the faintest star image is taken from 
the "Image Display" section; the faintest star magnitude is taken to be the limiting 
magnitude of the map. Under most circumstances the option should be switched on.



Star Label Options Dialog

This dialog allows you to specify which labels are used when star labelling is switched on.

Label Options
This group of check boxes specifies which label will be drawn for a star. The options are:

Proper Names, eg "Rigel".
Bayer Letters, eg "a".
Flamsteed Numbers, eg "31".

When labelling a star, this list is scanned from top to bottom. The star is labelled using the 
first existing label which corresponds to a checked option. Eg, if both the "Proper Names" 
and the "Bayer Letters" options are checked, a star which has both a proper name and a 
Bayer letter will be labelled with its proper name; a star with only a Bayer letter will be 
labelled with the letter.

Magnitude Filter
These radio buttons allow you to select whether all stars on the map are labelled, or only 
those stars brighter than the indicated magnitude.



Altitude/Azimuth Grid Options Dialog

This dialog controls the way the altitude/azimuth grid is drawn, if it is switched on.

Azimuth Label Options:

Label with:
These radio buttons determine whether azimuth is labelled using compass points (eg, "N", 
"NE"), or azimuth (true compass bearing) numbers (eg 180°).
Azimuth Interval:
If the azimuth axis of the map is being labelled with azimuth numbers, these radio buttons 
allow you to either specify how far apart the lines are drawn, or to allow SkyMap to 
determine the interval automatically.
Compass Interval:
If the azimuth axis of the map is being labelled with compass points, these radio buttons 
allow you to either specify how far apart the lines are drawn, or to allow SkyMap to 
determine the interval automatically.
Draw Azimuth Lines:
If this box is checked, an azimuth grid will be drawn on the map. If the box is left blank, just
points along the horizon line will be labelled.

Altitude Label Options

Label with:
These radio buttons determine whether lines of altitude are drawn across the map, or 
simply "tick marks" down the centre of the map.
Altitude Interval:
These radio buttons allow you to either enter an altitude labelling interval manually, or 
allow SkyMap to decide the interval automatically.

Notes:
In the majority of situations, leaving all labelling options set to "automatic" will produce a 
satisfactory result.



Colour Settings Dialog

This dialog allows the colour of each component of the map to be set. There are two ways 
to edit an item:

1. Double click the mouse on the name of the item.
2. Click on the name of the item to select it, then press the Edit... button.

In either case, a colour selector dialog will be displayed, allowing the colour of the item to 
be set. When all colours are set to your satisfaction, press the OK button, and all maps will 
be redrawn with the new colour scheme.

Notes:
1. Colour settings are global and apply to all maps. Changing the colour settings from 

any map alters them for all maps.
2. Colour settings are automatically saved between runs of the program - there is no 

need to use the File/Save Defaults... menu item to save a new colour selection.
3. There are two types of item - ones which just have a colour (such as the map 

background colour), and ones which have both a colour and a line style (such as 
constellation boundary lines). A slightly different dialog is displayed for the two cases.



Global Preferences Dialog (File/Preferences...)

This dialog sets global application options. The set options are automatically stored when 
the dialog is exited.

Maximize application window:
If this option is checked, SkyMap will maximize itself - ie use the whole screen - when run 
on subsequent occasions. If the option is not checked, the program will run as a normal 
sized window.
Maximize new map window:
If this option is checked, a new map window will be created in a maximized state - ie, using 
the whole of SkyMap's "workspace".
File Locations:
This section of the dialog allows you to specify the search paths that SkyMap will use when 
looking for various files. Options are:
Images: The directory in which SkyMap will look for image files when deciding whether a 
picture of an object is available for display. For more information, see Displaying Pictures 
Automatically.
Viewer: The complete path name of the program that SkyMap will run to display a picture. 
By default this will be SKYIMAGE.EXE, in the same directory as the SkyMap program. You 
may use any image viewer you wish - the only requirement is that it should be able to 
display the picture whose name is passed on the command line.
Startup Map Options:
Specifies what type of map, if any,    is created automatically when the program is run.
Tool Tips
These items configure the "pop up help" messages which appear as the mouse moves over
the buttons on the toolbar.
Display Help: Check this box to switch on the pop-up help messages; leave it blank to 
disable this feature.
Delay: The time in milliseconds that the mouse must be over a button before the help 
message appears. The default is 500 milliseconds - half a second.



Print Options Dialog

This dialog sets the options used when printing a map.

Colour
These radio buttons select whether a colour or black and white map is printed. If the colour 
option is selected, the printer colour options are used when printing the map; if the black 
and white option is selected, all objects are printed in black.
Note that the colour option can successfully be used to print a "grey scale" map on a black 
and white printer. The way that colours are translated to shades of grey will vary with the 
printer, and some experimentation will be required to produce a good result. This can 
produce excellent results on a PostScript laser printer; the results on a 9-pin dot matrix 
printer are not quite so good!

Show Map Key
This check box controls whether or not a key (legend) is displayed at the bottom of a 
printed map.



Find Planet Dialog

This dialog allows you to search for a planet, or the Sun or Moon. Select from the list the 
name of the object you wish to find, and press OK.

Notes:
On a Horizon Map only those planets currently above the horizon can be located. 
Attempting to search for a planet not currently visible will product the message "<object 
name> is not currently above the horizon".". A search on an Area Map will always be 
successful.



Find Constellation Dialog

This dialog allows you to search for a constellation. Select from the list the name of the 
constellation you wish to find, and press OK.

Notes:
1. The point in the constellation that the search will display in the centre of the map is 

the point at which the constellation name is displayed. This is not always in the 
physical centre of the constellation!

2. On a Horizon Map only those constellations currently above the horizon can be 
located. Attempting to search for a constellation not currently visible will product the 
message "<constellation name> is not currently above the horizon". Please note also
the point made above - you may be unable to successfully search for a constellation 
even though some part of it is actually visible. ". A search on an Area Map will always 
be successful.



Find Star by SAO Number Dialog

This dialog allows you to search for a star by its number in the SAO Star Catalog. Enter the 
catalog number in the dialog, and press OK.

Notes:
On a Horizon Map only those stars currently above the horizon can be located. Attempting 
to search for a star not currently visible will product the message "The object is not 
currently above the horizon". A search on an Area Map will always be successful.



Find Star by Proper Name Dialog

This dialog allows you to search for a star by its "proper name". Select from the list the 
name of the star you wish to search for, and press OK.

Notes:
For a Horizon map, the list of names will only contain the names of stars currently above 
the horizon. For an Area Map, the list will contain all the names in the star database.



Find Star by Bayer Letter Dialog

This dialog allows you to search for a star by its Bayer letter. Enter the letter, optionally a 
qualifying number, and a constellation, then press OK.

Notes:
1. On a Horizon Map only those stars currently above the horizon can be located. 

Attempting to search for a star not currently visible will product the message "The 
object is not currently above the horizon". A search on an Area Map will always be 
successful (assuming that the star is in the star database, that is).

2. You must always select a Greek letter and a constellation from the appropriate boxes 
on the dialog. A few stars have a number "qualifying" the letter (eg 2 Orionis), but for
the majority of stars which have no such number, enter zero into the number field.



Find Star by Flamsteed Number Dialog

This dialog allows you to search for a star by its Flamsteed number. Enter a number and a 
constellation, then press OK.

Notes:
1. On a Horizon Map only those stars currently above the horizon can be located. 

Attempting to search for a star not currently visible will product the message "The 
object is not currently above the horizon". A search on an Area Map will always be 
successful (assuming that the star is in the star database, that is).



Find Object by Popular Name Dialog

This dialog allows you to locate a deep sky object by its "popular name" (such as "Whirlpool
Galaxy", for example). Select from the list the name of the object you wish to find, and 
press OK.

Notes:
1. On a Horizon Map, only those objects currently above the horizon can be located. 

Attempting to search for an object not currently visible will product the message "The
object is not currently above the horizon". A search on an Area Map will always be 
successful (assuming that the object is in the database, that is).

2. This dialog displays the contents of the ASCII text file SACPOP.SKY. You can add your 
own entries to this file, or edit existing ones, using any convenient text editor (such 
as "NotePad", for example). Each line of the file has the format:
Popular Name|Catalog Number
where "Popular Name" is the descriptive name which appears in the dialog box, and 
"Catalog Number" is the corresponding catalog number which is searched for when 
that entry is selected. The two are separated by the vertical bar character "|". For 
example, one line of the file says:
Dumbbell Nebula|M 27
This means that if "Dumbbell Nebula" is selected from the listbox, the deep sky 
database will be searched for the object "M 27".



Find Object by Catalog Number Dialog

This dialog allows you to locate a deep sky object by its catalog number (eg "M31", "NGC 
4565", "3C 273"). Enter the name of the object you wish to locate and press OK.

Notes:
1. The search string entered is not case sensitive, and all spaces are ignored. Note, 

however, that all other characters (such as "-") are significant. For example, if you 
want to locate the object "NGC 7088" you could enter any of the following:
ngc7088
Ngc 7088
NGC 7 0 88

2. You can search for an object by entering either its "main" or "alternative" name. For 
example, searching for either "M42" or "NGC 1976" will locate the Orion Nebula.

See also:
Deep Sky Object Catalogs.
Dreyer Object Descriptions



Find Comet Dialog

This dialog allows you to search for a comet. Select from the list the name of the comet you
wish to locate, and press OK.
Note that, for a horizon map, only the names of those comets currently above the horizon 
will be displayed.



Find Asteroid Dialog

This dialog allows you to search for an asteroid. Select from the list the name of the 
asteroid you wish to locate, and press OK.
Note that, for a horizon map, only the names of those asteroids currently above the horizon
will be displayed.



Find Messier Object Dialog

This dialog allows you to search for a Messier object. Enter the number of the Messier 
object you wish to locate and press OK.



Comet Selection Options Dialog

SkyMap maintains a catalogue of comets in the data file COMET.SKY. Since comets are 
typically only visible for a few months either side of their perihelion passage (the point at 
which they are closest to the Sun), you will normally only want to display the positions of a 
few comets at any one time. This dialog allows you to select which comets from the 
catalogue are "active" - ie, will have their position calculated - and also provides facilities 
for maintaining the comet catalogue.
Most of the dialog is occupied by two listboxes:
Known Comets
This is the list of all the comets in the catalogue.
Active Comets
This is the list of comets whose positions will be calculated by SkyMap for the current map.

Selecting Comets for Display
To add a comet to the Active list, highlight its name in the Known list, and click the 
Add>> button. The name of the comet will appear in the Active list. As a shortcut, simply 
double click the name of the comet in the Known list.
To remove a comet from the Active list, highlight its name in the list, and click the 
<<Remove button. The name of the comet will disappear from the Active list. As a 
shortcut, simply double click the name of the comet in the Active list.
Note that although the name of any comet in the catalogue can be added to the Active 
list, only those comets less than a year either side of perihelion passage will actually be 
displayed on the map. This is due to problems in computing the position of a comet in a 
near-parabolic orbit a long way from perihelion.

Maintaining the Comet Catalogue
The buttons in the Catalogue section of the dialog allow the user to maintain the 
catalogue. The available options are:
Add...
Add a new comet to the catalogue. When this button is pressed, the Comet Orbit Dialog is 
displayed, allowing the user to enter information about the orbit of the new comet.
Edit...
Edit the orbit of the comet whose name is currently highlighted in the Known comets list. 
When this button is pressed, the Comet Orbit Dialog dialog is displayed.
Delete
Delete from the catalogue the comet whose name is currently highlighted in the Known 
comets list. You will be asked for confirmation before the comet is deleted.

Setting a Magnitude Limit
The radio buttons in the Magnitude selection group allow comets to be selected by 
magnitude. This can be very useful, to prevent a fruitless search for a 17th magnitude 
comet with a pair of 10x50 binoculars, for example! The options available are:
All objects



Display on the map the positions of all the comets on the Active list.
Brighter than mag <n>
Only display on the map the positions of those comets from the Active list brighter than 
the indicated magnitude.



Comet Orbit Dialog

This dialog allows information about a comet to be entered or edited. Information contained
in the dialog is described below. The orbital elements should all be referred to epoch 
J2000.0.

Name:
The name of the comet. Up to 31 characters can be entered. A short period comet (one 
with an orbital period less than 200 years) has a name beginning with "P/".
Image:
The name of a file containing a picture of the comet. Only a file name should be entered 
here - the file is assumed to be located in the image file directory specified in the Global 
Preferences Dialog.
T:
The date of perihelion passage of the comet. The time scale used for this is Terrestrial 
Dynamical Time (TDT).
q:
The distance of the comet from the Sun at the time of perihelion passage, in astronomical 
units (AU).
e:
The eccentricity of the comet's orbit. An eccentricity of 0.0 means that the orbit is circular, 
whilst a value of 1.0 indicates a parabola. The majority of comets have an eccentricity 
between 0 and 1.
w:
The argument of perihelion, in degrees.
W:
The longitude of the ascending node of the orbit, in degrees.
i:
The inclination of the orbit, in degrees.
Magnitude Parameters:
These numbers (H and G) are used to calculate the magnitude of the comet given its 
distance from the Earth and Sun.



Star Information Dialog

This dialog displays information about a star. The information displayed will differ from star 
to star, but could include the following:

Catalog Number
The identity of the star in the SAO or GSC catalog is displayed in the dialog's title bar.
Constellation
The name of the constellation containing the star.
Proper Name
A name, such as "Rigel", by which the star is commonly known.
Bayer Letter
The Bayer identification of the star in the constellation, such as "b Orionis".
Flamsteed Number
The Flamsteed identification of the star in the constellation, such as "19 Orionis".
Magnitude
The visual magnitude of the star.
RA, Dec
The star's right ascension and declination.
Alt, Az
The star's apparent altitude and azimuth.
Rise, Set, Transit
The local time that the star rises, transits the observer's meridian, and sets. A "-" displayed 
before a rise time indicates that the event occurred the previous day; a "+" displayed after 
a set time indicates that the event occurs the next day. In the case of a circumpolar star 
(or, for an Area Map, a star which never rises from the observer's location), only a transit 
time will be displayed.

Notes:
1. For a Horizon Map, if the position is labelled "epoch J2000", the position shown is the 

uncorrected catalog position of the star for epoch J2000.0. If the position is labelled 
"epoch of date", the position is the apparent position at the epoch of observation, 
fully corrected for proper motion, precession, nutation, and aberration.

2. For an Area Map, if the position is labelled "epoch J2000", the position shown is the 
astrometric position of the star for J2000.0, corrected only for proper motion. If the 
position is labelled "epoch of date", the position is the apparent position at the epoch 
of observation, fully corrected for proper motion, precession, nutation, and 
aberration.

3. In both the above cases, the displayed right ascension and declination does not 
include a correction for refraction; the altitude and azimuth, however, does take 
refraction into account.



4. The altitude and azimuth, and the times of rise, set and transit, are computed from 
the displayed right ascension and declination. They will only be rigorously correct, 
therefore, if the star's position is displayed for the epoch of observation. In modern 
times, however, the difference between the position computed from the J2000 
catalog position, and the apparent position will be very small, and only important if 
the utmost rigour is required.



Planet Information Dialog

This dialog displays information about a planet. Several "pages" of information are 
available, and are selected using the group of radio buttons on the right side of the dialog. 
The information available is described below:

Local Information
This page displays information about the planet which varies according to the observer's 
location. The information available is:
Right Ascension, Declination
The apparent topocentric coordinates of the planet, corrected for the effects of diurnal 
parallax. This will normally differ from the geocentric position by a small amount, but the 
effect is negligible except in the case of the Moon.
Altitude
The apparent altitude of the planet, including the effects of refraction.
Azimuth
The apparent azimuth of the planet.
Rise
The local time at which the planet rises. A "-" after the time indicates that the event 
occurred the previous day.
Transit
The locat time at which the planet transits the meridian - ie is due south in the northern 
hemisphere, or due north in the southern hemisphere.
Set
The local time at which the planet sets. A "+" after the time indicates that the event occurs
the following day.

Geocentric Information
This page displays information about the planet as it would hypothetically be seen from the
centre of the Earth - ie independent of the position of the observer. The items displayed 
are:
Right Ascension, Declination
The apparent geocentric right ascension and declination of the planet. This is rigorously 
reduced from mean to apparent place.
Constellation
The name of the constellation the planet is currently in.
True Distance
The geometric distance between the planet and the Earth. For all objects except the Moon 
the figure is expressed to high accuracy in AU, and a rounded figure in Km is also given. For
the Moon, the accurate distance in Km is given.

Heliocentric Information



This page displays information about the planet relative to the Sun. The items displayed 
are:
Ecliptic Longitude
The ecliptic longitude of the planet, for the mean equinox and ecliptic of date.
Ecliptic Latitude
The ecliptic latitude of the planet, for the mean equinox and ecliptic of date.
Radius Vector
The distance of the planet from the Sun. The distance is given to high accuracy in AU, and 
a rounded figure in Km is also given.

Physical Information
This page displays physical information about the planet. The items available are:
Magnitude
The apparent magnitude of the planet. Note that, in the case of Saturn, this figure does not 
take any account of the illumination of the ring system, so the planet will be brighter than 
the displayed figure.
Phase
The phase of the planet. This corresponds to the fraction of the planet's disk which is 
illuminated by the Sun.
Equatorial Diameter
The equatorial diameter of the planet's apparent disk, in seconds of arc.
Polar Diameter
The polar diameter of the planet's apparent disk, in seconds of arc. If this is not given, the 
planet's disk is assumed to be circular.
Phase Angle
The angular separation between the Sun and the Earth, as seen from the planet. This is 
simply an alternative method of expressing the phase of the planet - the smaller the phase 
angle, the closer the phase is to "full", as seen from the Earth.
Elongation
The angular separation between the planet and the Sun. A small elongation indicates that 
the planet can only be observed shortly before sunrise or after sunset.
Light Time
The length of time it takes for light to travel from the planet to the Earth at the time of 
observation. This is a measure of how "old" the image of the planet we see actually is. Eg, if
the light time of Saturn is 1h 25m, we are actually seeing Saturn as it was 1h 25m ago 
(and, of course, in the location it occupied at that time).

Notes:
1. For a Horizon Map, the right ascension and declination of the planet is always 

referred to the mean equinox and ecliptic of date.
2. For an Area Map, the right ascension and declination are astrometric positions for 

epoch J2000.0 if the "astrometric" option is enabled, and are apparent positions 



referred to the mean equinox and ecliptic of date otherwise.
3. In both the above cases, the displayed right ascension and declination does not 

include a correction for refraction; the altitude and azimuth, however, does take 
refraction into account.



Deep Sky Information Dialog

This dialog displays information about a deep sky object. The exact information displayed 
will vary from object to object, but could include the following:

Name
The main name of the object will appear on the title bar of the dialog.
Type of object
A description of the basic classification of the object - eg "open cluster", "galaxy", etc.
Catalog
The name of the catalog from which the main name of the object is taken.
Other Names
One or more alternative names for the object. Most objects in the Messier catalog, for 
example, will also have an NGC number. For example, M42 (the Orion nebula) is also known
as NGC1976.
Magnitude
The magnitude of the object. For extended objects, this is normally the integrated 
magnitude - ie the total light emitted from the object.
Size
The approximate size of the object, in either minutes or seconds of arc. For galaxies, the 
size of both the major and minor axes is normally given, together with a position angle. The
position angle is the angle between the major axis and north, measured anticlockwise from 
north.
Number of Stars
For clusters, this gives an indication of the number of visible stars in the cluster.
Magnitude of Brightest Star
For star clusters, the magnitude of the brightest star. For planetary nebulae, the magnitude
of the central star.
Classification
The classification of the object. This information is only present in the registered version of 
the program.
Description
The Dreyer description of the object. This information is only present in the registered 
version of the program.
Notes
Brief notes about the visual appearance of the object. This information is only present in 
the registered version of the program.
RA, Dec
The apparent right ascension and declination of the object.
Alt, Az



The apparent altitude and azimuth of the object.
Rise, Set, Transit
The local time that the object rises, transits the observer's meridian, and sets. A "-" 
displayed before a rise time indicates that the event occurred the previous day; a "+" 
displayed after a set time indicates that the event occurs the next day. In the case of a 
circumpolar object (or, for an Area Map, an object which never rises from the observer's 
location), only a transit time will be displayed.



Comet Information Dialog

This dialog displays information about a comet. The items displayed are as follows:

Name
The name of the comet.
Magnitude
The visual magnitude of the comet. Note that this is only a very approximate figure - the 
magnitude of a comet is notoriously difficult to predict! Note also that comets are normally 
diffuse objects, and the magnitude refers to the total brightness of the comet - in order to 
see a 10th magnitude comet it will probably be necessary to be able to see 13th magnitude
stars in the same field!
Elongation
The angular separation between the comet and the Sun, in degrees.
Distance
The distance of the comet from the Earth, in both AU and Km.
Radius Vector
The distance of the comet from the Sun, in both AU and Km.
Constellation
The constellation the comet is in.
RA, Dec
The apparent right ascension and declination of the comet for the mean equinox and 
ecliptic of date.
Alt, Az
The apparent altitude and azimuth of the comet.
Rise, Set, Transit
The local time that the comet rises, transits the observer's meridian, and sets. A "-" 
displayed before a rise time indicates that the event occurred the previous day; a "+" 
displayed after a set time indicates that the event occurs the next day. In the case of a 
circumpolar comet (or, for an Area Map, a comet which never rises from the observer's 
location), only a transit time will be displayed.



Asteroid Information Dialog

This dialog displays information about an asteroid. The items displayed are as follows:

Name
The name of the asteroid.
Magnitude
The visual magnitude of the asteroid.
Elongation
The angular separation between the asteroid and the Sun, in degrees.
Distance
The distance of the asteroid from the Earth, in both AU and Km.
Radius Vector
The distance of the asteroid from the Sun, in both AU and Km.
Constellation
The constellation the asteroid is in.
RA, Dec
The apparent right ascension and declination of the asteroid for the mean equinox and 
ecliptic of date.
Alt, Az
The apparent altitude and azimuth of the asteroid.
Rise, Set, Transit
The local time that the asteroid rises, transits the observer's meridian, and sets. A "-" 
displayed before a rise time indicates that the event occurred the previous day; a "+" 
displayed after a set time indicates that the event occurs the next day. In the case of a 
circumpolar asteroid (or, for an Area Map, an asteroid which never rises from the observer's
location), only a transit time will be displayed.



Area Map View Dialog

This dialog sets the centre and the field of view of the area map.

Map Centre
The right ascension and declination of the centre of the map.
Field of View
The top-to-bottom field of view of the map, in degrees. This must be between 0.1° and 
180°.



Visible Objects Dialog

This dialog provides a rapid way of selecting the type of objects to be displayed on the 
map. Each type of object has a check box on the dialog. Check the boxes corresponding to 
those objects you wish to display; leave blank the boxes corresponding to the items you do 
not wish to see. Note that certain items on the map, such as the Ecliptic line, can only be 
switched on and off using this dialog.



Deep Sky Options Dialog

This dialog allows you to select which deep sky objects will be displayed on the map. The 
items displayed are as follows:

Object Selection
This listbox allows selection of the types of object to be displayed. An object type will be 
displayed if the corresponding line in the listbox is currently highlighted.
If the "All Objects" line at the top of the list is highlighted, all objects in the deep sky 
database will be displayed. If this line is not highlighted, only those objects whose specific 
type is highlighted in the rest of the list will be displayed.

Catalog Selection
Selects which catalog objects will be displayed from. The options are:
All Catalogs: Display objects from all catalogs in the database.
Messier Catalog: Display only objects from the Messier catalog.

Magnitude Selection
This option allows a magnitude filter to be applied to the objects displayed. You may 
request that either all (otherwise eligible) objects are displayed, or that only objects 
brighter than a specified magnitude should be displayed.

Display Labels
Specifies whether or not deep sky objects will be labelled.

Show Object Sizes
This option (only available on the Area Map) allows you to specify whether deep sky objects
will be displayed using a symbol of a standard size, or with their actual size and (in the case
of galaxies) orientation.

Notes:
1. Not all deep sky objects in the database have size information available. Those which 

do not will be displayed with a standard symbol regardless of the setting of the "Show
object sizes" option. Those objects which do have size information will only be 
displayed with the correct size if that size is larger than the standard size symbol.
What this means in reality is that when you first draw a map you will probably see 
"large scale" structures such as bright and dark nebulae, open clusters, etc, 
displayed with circles of varying sizes, and standard symbols used for small objects 
such as galaxies, globular clusters, etc. As you zoom in on a galaxy cluster, for 
example, you should see more and more of the galaxies drawn with their correct size 
and orientation.

2. Not all objects in the database have magnitude information available. Dark nebulae 
have no associated magnitude by definition - they are "black" objects only seen in 
"silhouette" against a brighter object such as an emission nebula or the Milky Way 



background stars. Dark nebulae will always therefore be displayed (if selected), 
regardless of the current setting of the "magnitude filter". Other objects such as faint 
galaxies simply have no magnitude information stored in the database; these objects 
will be filtered out by any setting of the magnitude filter, ie they will only be 
displayed if the magnitude selection option is set to "All objects".

3. This dialog allows the selection of deep sky objects. In order to actually display the 
selected objects on the map, they must be made visible using either the "Deep Sky 
Objects" toolbar button, or by selecting the appropriate option in the object visibility 
dialog on the View menu.



Track Object Dialog

This dialog specifies the way in which an object track will be calculated and displayed.
The top portion of the dialog determines the frequency and number of position calculations,
and the interval at which positions should be labelled. The "labelled" positions will be 
marked with a cross, and may optionally also display the date and (except in the case of 
planets) magnitude of the object.
The other portions of the dialog determine what information will be displayed at each 
labelled point, and also whether the labels will be drawn horizontally (for objects moving N-
S) or vertically (for objects moving E-W).

Notes:
1. Object tracks are drawn as a sequence of line segments joining up the calculated 

positions. Reducing the interval at which positions are calculated will result in a 
smoother track, obviously at the expense of increased calculation time. For example, 
specifying:
Calculate position every 5 days
Calculate 20 positions
Labelling interval: 2 positions
and:
Calculate position every 1 days
Calculate 100 positions
Labelling interval: 10 positions
will both produce the same track showing the object's motion for 100 days, with 
labels every 10 days, but the second of these tracks will contain 5 times as many 
points, and will take 5 times longer to calculate. Increasing the number of positions 
calculated to obtain a smoother track can be useful, especially in the case of objects 
near the stationary points of retrograde loops.

2. If you simply want a line drawn with no labelled points, enter a labelling interval of 0 
(zero).

3. The first position on the track will be calculated for the date and time currently 
selected for the map. Each subsequent position will add to this date and time the 
appropriate calculation interval. If, as is normally the case, the calculation interval is 
a whole number of days, you may wish to set the map time to midnight (0h) before 
calculating the track.



Planet Options Dialog

This dialog sets the options for display of planets. The items available are:

Label with
Selects whether planets are labelled with names, or astronomical symbols.

Draw dark limb of Moon
If this option is switched off, the Moon is drawn as it appears in the sky. If the option is 
switched on, the dark (unilluminated) limb of the Moon is drawn with a dotted line. This can
be useful for viewing eclipses and lunar occultations.



Map Information Dialog

This dialog displays information about the current map. The information displayed is as 
follows:

Local Time
The local time and date.
UTC
The UTC (Greenwich mean time) corresponding to the local time.
TDT-UT
The current value of "delta T" - the difference between terrestrial dynamical time and UT 
(GMT), in seconds.
Julian Day
The Julian day number corresponding to the UTC.
Sidereal Time
The local apparent sidereal time.
Latitude and Longitude
The location of the observer.



Registration Benefits Dialog

This dialog displays the length of time that the unregistered version of the program has 
been in use for, and explains the benefits of registering the program.



Automatic Map Update Dialog

This dialog allows the user to control the rate at which map time automatically advances 
when time skip mode is switched on. The items available on the dialog are:

Every
The interval of "real time" after which the map is updated.
Advance map time by
The amount by which the map time is changed at every update.
Direction
Allows you to specify whether the map time is moved forwards or backwards at every 
update.



Asteroid Selection Options Dialog

SkyMap maintains a catalogue of asteroids in the data file ASTEROID.SKY. The catalog can 
contain a large number of asteroids, but you will normally only want to display a small 
number of these at any one time. This dialog allows you to select which asteroids from the 
catalogue are "active" - ie, will have their position calculated - and also provides facilities 
for maintaining the asteroid catalogue.
Most of the dialog is occupied by two listboxes:
Known Asteroids
This is the list of all the asteroids in the catalogue.
Active Asteroids
This is the list of asteroids whose positions will be calculated by SkyMap for the current 
map.

Selecting Asteroids for Display
To add an asteroid to the Active list, highlight its name in the Known list, and click the 
Add>> button. The name of the asteroid will appear in the Active list. As a shortcut, 
simply double click the name of the asteroid in the Known list.
To remove an asteroid from the Active list, highlight its name in the list, and click the 
<<Remove button. The name of the asteroid will disappear from the Active list. As a 
shortcut, simply double click the name of the asteroid in the Active list.

Maintaining the Asteroid Catalogue
The buttons in the Catalogue section of the dialog allow the user to maintain the 
catalogue. The available options are:
Add...
Add a new asteroid to the catalogue. When this button is pressed, the Asteroid Orbit Dialog 
is displayed, allowing the user to enter information about the orbit of the new asteroid.
Edit...
Edit the orbit of the asteroid whose name is currently highlighted in the Known asteroids 
list. When this button is pressed, the Asteroid Orbit Dialog dialog is displayed.
Delete
Delete from the catalogue the asteroid whose name is currently highlighted in the Known 
asteroids list. You will be asked for confirmation before the asteroid is deleted.

Setting a Magnitude Limit
The radio buttons in the Magnitude selection group allow asteroids to be selected by 
magnitude. This can be very useful, to prevent a fruitless search for a 17th magnitude 
asteroid with a pair of 10x50 binoculars, for example! The options available are:
All objects
Display on the map the positions of all the asteroids on the Active list.
Brighter than mag <n>
Only display on the map the positions of those asteroids from the Active list brighter than 



the indicated magnitude.



Asteroid Orbit Dialog

This dialog allows information about an asteroid to be entered or edited. Information 
contained in the dialog is described below. The orbital elements should all be referred to 
epoch J2000.0.

Name:
The name of the asteroid. Up to 31 characters can be entered.
Image:
The name of a file containing a picture of the asteroid. Only a file name should be entered 
here - the file is assumed to be located in the image file directory specified in the Global 
Preferences Dialog.
T:
The reference date of the mean anomaly - ie the date at which the asteroid has the mean 
anomaly specified by M.. The time scale used for this is Terrestrial Dynamical Time (TDT).
M:
The mean anomaly of the asteroid at the reference date T, in degrees.
a:
The semi-major axis of the orbit, in astronomical units (AU).
e:
The eccentricity of the orbit. An eccentricity of 0.0 means that the orbit is circular, whilst a 
value of 1.0 indicates a parabola. All asteroids have an orbital eccentricity less than 1.
w:
The argument of perihelion, in degrees.
W:
The longitude of the ascending node of the orbit, in degrees.
i:
The inclination of the orbit, in degrees.
Magnitude Parameters:
These numbers (H and G) are used to calculate the magnitude of the asteroid given its 
distance from the Earth and Sun.



Daily Phenomena (Tools Menu)

Displays the local times at which the Sun, Moon and planets rise, transit the local meridian 
and set for the current observation date.

Notes:
1. For each object, the dialog displays the time, on the date of observation, at which the

object is on the local meridian, ie is due south (in the northern hemisphere) or due 
north (in the southern hemisphere). The time of rising is always before this, and the 
time of setting is always after it. A "-" following a rise time indicates that the time is 
actually in the previous day, whilst a "+" following a set time indicates that the time 
is in the next day.

2. If the object is either circumpolar (never sets), or never rises as seen from the 
observer's position, only a transit time is shown.



Planet Visibility (Tools Menu)

Displays a diagram showing the approximate altitude and azimuth of all visible planets, 
together with the Sun and Moon. This is just a quick way of seeing what is currently visible.



Window Title (Options/Setup/Window Title)

This dialog allows the title of the map window to be set or edited. This can be especially 
useful when saving a map to a file, as a means of giving the map a descriptive name.



Eyepieces Dialog

Displays a list of eyepieces and telescopes, showing the magnification and field of view 
resulting from using any eyepiece with any telescope.
This dialog can be invoked in two ways:
1. Using the Tools/Eyepiece Database menu item from either the Horizon Map or the 

Area Map. This method of invoking the dialog just allows the data to be viewed and 
edited.

2. By pressing the right mouse button on an Area Map and selecting Eyepiece... from 
the pop-up menu. As well as allowing the data to be viewed and modified, this 
method of invoking the dialog allows a "field of view" circle for the current 
telescope/eyepiece combination to be displayed on the map, centred on the point at 
which the mouse button was clicked.

Modifying the Data
Most of the space in the dialog is occupied by a list of eyepieces on the left, and a list of 
telescopes on the right. Each list has three buttons below it:
Add
Add a new entry to the list. Pressing this button displays a dialog allowing details of the 
new eyepiece or new telescope to be added to the list.
Edit
Edits the currently selected item in the list. Pressing this button displays a dialog displaying
the data for the currently selected eyepiece or telescope, and allowing the information to 
be edited.
Delete
Deletes the currently selected item from the list. Confirmation will be requested before the 
item is selected.

Current Selection
This section of the dialog displays the magnification and true field of view that would result 
from the combination of the selected eyepiece and the selected telescope.

Draw on Map
Pressing this button dismisses the dialog, displaying a circle representing the field of view 
of the current telescope/eyepiece combination on the map. To dismiss the dialog without 
drawing a field of view circle, press the Cancel button.

Notes:
To remove the field of view circles and object tracks from the map, select the View/Clean 
Up Map menu item.



Eyepiece Details Dialog

Displays the data for an eyepiece, allowing information to be entered and edited.
Description
The name of the eyepiece, up to a maximum of 31 characters.
Focal Length
The focal length of the eyepiece, in mm.
Apparent Field
The apparent field of view of eyepiece, in degrees. The true field visible through the 
eyepiece will be this apparent field, divided by the magnification.



Telescope Details Dialog

Displays the data for a telescope, allowing information to be entered and edited.
Description
The name of the telescope, up to a maximum of 31 characters.
Diameter
The diameter of the primary mirror or objective lens of the telescope, in mm. If the 
mirror/lens size is quoted in inches, multiply by 25.4 to convert to mm.
Focal Ratio
The focal ratio of the telescope. This will normally be quoted as, for example, "f/10" or 
"f/6.3".



RA/Dec Grid Options
This dialog controls the way in which the grid of right ascension and declination is drawn on
the map.

Grid Drawing
Automatic
The spacing of the grid lines is determined automatically. This will be satisfactory for most 
maps.
Manual
The spacing of the grid lines is specified manually by the settings elsewhere in this dialog.

Draw Labels
If this box is checked, the grid will be labelled at each intersection of right ascension and 
declination lines. If the box is left blank, no labels will be drawn.

Manual Grid Parameters
These settings are used if the "manual" setting is selected in the top portion of the dialog.
RA Line Spacing/draw every
The separation of lines of right ascension, in minutes of time, and the frequency at which 
points on the line are calculated, in degrees of declination.
Dec Line Spacing/draw every
The separation of lines of declination, in degrees, and the frequency at which points on the 
line are calculated, in minutes of right ascension.

Notes:
Each grid line consists of a series of points connected by straight lines. The point frequency
(ie the "draw every <x> degrees/minutes" number) controls the "smoothness" of each grid 
line. Reducing this number will make the curve of a grid line "smoother", but obviously at 
the expense of increased calculation time, especially on a slow computer.



Bitmap Dimensions Dialog

This dialog specifies the size of the bitmap to be created, in pixels.
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Using the Help System Effectively

This help system contains the complete documentation for SkyMap. The contents page 
contains items of general interest, which can be reached from any point in the system by 
pressing the Contents button.
Unlike a printed manual, this help system is not designed to be read in isolation. It is very 
much an interactive system, and is intended to be used in conjunction with the SkyMap 
program itself. Several ways of accessing help information are described below:

Help on using a map
To display help information about using a particular type of map, press the F1 key whilst 
the map is displayed. A page of general information will be displayed, together with a list of
related topics which may be of interest.

Help for a menu item or tool bar button
As you move the mouse pointer over a menu item or tool bar button, a brief description of 
the item will appear on the status bar at the bottom of the screen. To obtain a more 
extensive description of the item, press the context sensitive help button (or the keyboard 
equivalent, which is SHIFT+F1):

The mouse pointer will change to an arrow and question mark. Now, simply click the mouse
over any menu item or button and a help screen will be displayed describing the use of that
command or button.

Help for a dialog box
To display a help screen for a dialog box, press the F1 key whilst the dialog box is on the 
screen.



ASP Ombudsman Statement

This program is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for members' 
products.    Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536.



What is Shareware?

Shareware distribution gives users a chance to try software before buying it. If you try a 
shareware program and continue using it, you are expected to register. Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and wallet, whether it's commercial or Shareware. The Shareware system 
makes fitting your needs easier, because you can try before you buy. And because the 
overhead is low, prices are low also. Shareware has the ultimate money-back guarantee -- if
you don't use the product, you don't pay for it!



Contacting the Author

If you have any suggestions about ways in which SkyMap could be improved (and I'm sure 
there are many!), or you have any questions you'd like answered, feel free to contact the 
author by any of the following methods:

Electronic mail
I can be contacted at either of the following addresses:

CompuServe: 100113,1140
Internet: chris@chrism.demon.co.uk

Post
You can send me a letter at the following address:

Chris Marriott
9, Severn Road
Culcheth
Cheshire WA3 5ED
UK

Support in the USA and Canada
SkyMap is exclusively distributed in the United States and Canada by:

JASC, Inc.
10901 Red Circle Drive, Suite 340
Minnetonka, MN 55343
USA

If you have any questions about the software, you may contact JASC at this address or by 
phone, fax or e-mail at:

Phone: 612-930-9171
FAX: 612-930-9172
Orderline 800-622 2793
CompuServe: 76226,2652
Internet: 76226.2652@compuserve.com
JASC BBS: 612-930-3516



What's New in SkyMap v2.2?

This list provides a quick summary of the new features in SkyMap v2.2, for those people 
familiar with the previous version of the program:

- SkyMap can now draw maps using the 19 million object Hubble Guide Star Catalog, 
version 1.1, published as a set of two CD-ROMs by the Space Telescope Science 
Institute. This database covers the whole sky to below magnitude 14, so displays all 
stars visible in typical amateur telescopes. This facility is not available in the 
evaluation version of the program, but only in the SkyMap/GSC version, available as a
registration option. Please refer to the registration forms for more details.

- A grid of right ascension and declination lines can now be displayed on a Horizon 
Map.

- The N,E,S,W buttons on the Horizon Map toolbar now remain "pressed in" when the 
map is drawn for those directions. This makes it easy to see at a glance which (if any)
cardinal direction the map is facing.

- Two new buttons on the toolbar (and equivalent keyboard shortcuts) provide an easy 
way of increasing and decreasing the limiting magnitude of the stars visible on the 
map.

- A new auto magnitude scale option allows the program to automatically assign sizes 
to star image circles, rather than having to set them up manually.

- A new status bar panel displays the current limiting magnitude of the stars visible on 
the map.

- Clicking the left mouse button over two points on a map displays their angular 
separation in a new panel on the status bar.

- New user-editable data files of telescope and eyepiece data have been added. These 
allow you to quickly see the magnification and field of view resulting from any 
combination of eyepiece and telescope. On an Area Map the resulting field of view 
can be displayed as a circle on the map.

- A new option on the Area Map popup menu allows Telrad® finder circles to be 
displayed. The Telrad finder is a very popular device, and this is a much requested 
feature.

- Added "Tool Tips" to the toolbar. These are short help messages which pop up after 
the mouse has been over a button for a brief period, describing the function of that 
button. This feature can be disabled using a new option on the global preferences 
dialog.

- An Area Map can now be drawn from a Horizon Map by dragging a selection rectangle
with the left mouse button. This is a much more convenient method than the 
previous one of pressing the right button over a point on the map because it allows 
the map size, as well as the centre, to be selected visually.

- A new Area Map can now be drawn from an existing one by dragging a selection 
rectangle with the left mouse button. It was not previously possible to draw a new 
Area Map from an existing one.

- On the Area Map, the tracks of an arbitrary number of moving objects can now be 
displayed simultaneously. Previously, only a single object track could be displayed.

- Maps can now be saved as a Windows bitmap image file (.BMP). This is a much-
requested feature for saving a permanent record of a map. It's also a great way of 
creating Desktop "Wallpaper" files!



- A new View/Copy menu item copies the map to the Windows clipboard, for pasting 
into other applications.

- The line of the ecliptic can be displayed on both Horizon and Area maps.
- A limiting magnitude can now be specified for the display of comets and asteroids. 

This is useful to prevent, for example, the display of 17th magnitude comets if you 
only have a pair of 10x50 binoculars!

- If a date more than 50 years from the 2000AD "epoch" is selected, the program will 
automatically switch to high-precision calculation mode, to prevent the display of 
incorrect maps which don't take account of precession.

- Times of rise, set and transit can now be displayed for all objects.



Introduction
SkyMap is a "Planetarium" program for Microsoft Windows version 3.1 or later.    It will 
display a map of the sky as seen from any point on Earth for any date between 4000BC and
8000AD.    Two different types of map can be drawn - a "Horizon" map showing the 
observer's local horizon, and a "Sky Area" map showing a detailed view of a small area of 
the sky.    You can get information about any object displayed on the map by simply pointing
at the object with the mouse and clicking the button.    The display of additional 
information, such as constellation figures or star labels can be switched on and off with a 
click of the mouse button, making it easy to see exactly what you want without being 
overwhelmed by unwanted information.    When you have the map just as you want it, you 
can print it on any printer supported by Windows, in either black and white or colour.
SkyMap can also display photographic images, supplied in the form of GIF or Windows 
bitmap files.      Thousands of such images are freely available on bulletin boards and 
commercial information systems such as CompuServe.    This allows you to build up your 
own personal library of astronomical photographs which, coupled with the map displays, 
really helps to bring the sky to life!
There are a number of planetarium programs available today.    Unlike some of these, 
SkyMap makes no claims of blinding calculation speeds.    Instead, what SkyMap 
concentrates on is accuracy.    When writing SkyMap I've used the most accurate methods 
available to me for all the calculations.    This accuracy makes SkyMap equally suited for 
both the novice astronomer who just wants to know "what's that bright object up there?" 
and the serious amateur or professional astronomer who wants a detailed "finder chart" for 
a faint galaxy.
SkyMap carries out its calculations in as efficient as manner as possible, but it never 
compromises accuracy for the sake of speed.    An increase in speed can always be 
achieved by using a faster computer!    Having said all that, the speed is still reasonable; on
the author's 33MHz 486-based PC for example, the horizon map, with default settings, is 
computed and drawn in about 5 seconds.
Whilst developing SkyMap I've received the help and encouragement of a number of 
people.    I'd especially like to thank David Webber for many useful suggestions and help 
with the mathematical problems I encountered, and Steve Moshier for generously 
consenting to allow me to use many of his coding ideas for various astronomical 
calculations.    I'd also like to thank the Saguaro Astronomy Club for giving me permission to
use their excellent deep sky object database in this program. Finally, I'd like to thank Jean 
Meeus for writing the book "Astronomical Algorithms" (Willman-Bell, 1991), without which 
this program could never have existed.

Chris Marriott
January 1995



Data Sources and Precision

The sources of the data used by SkyMap are as follows:

Stars
Planets and Sun
Moon
Deep Sky Objects
Time Corrections



Stars

Smithsonian Astrophysical Observatory (SAO) star catalog,    (SAO Staff, 1966), 1990 
machine readable version, as supplied on NASA's National Space Science Data Center's 
"Selected Astronomical Catalogs, Volume 1" CD-ROM.

The SAO star catalog is a catalog of 258,997 stars to epoch J2000.0, and is reasonably 
complete down to magnitude 9.5 or so.    The star database supplied with the shareware 
version of SkyMap contains all the stars from the SAO catalog down to magnitude 7 - a total
of 15,925 stars.    Larger databases, up to and including the full SAO catalog,    are supplied 
to registered users of SkyMap - refer to the separate registration form for details.

SkyMap rigorously reduces star positions from mean to apparent place.    The following 
corrections are applied:

Precession
Proper Motion
Nutation
Aberration

In the case of the Horizon Map, the apparent place is used to compute the local altitude 
and azimuth of the star, and the altitude is then corrected for the effects of refraction.



Planets and Sun

The positions of the Sun, and the planets Mercury to Neptune are computed using a subset 
of    Bretagnon and Francou's VSOP87 planetary theory, as described in the book 
"Astronomical Algorithms", by Jean Meeus (Willman-Bell, 1991).

Spot checks against recent editions of the "Astronomical Almanac" indicate that the mean 
error in the computed positions of the planets is under half a second of arc, with peak 
errors of about one arc second.    For comparison, the apparent diameter of the planet 
Neptune is about 2", whilst that of Jupiter is typically 35".

Positions of Pluto are calculated using an accurate expression for the planet's motion valid 
for the years 1885 - 2099 (E.Goffin, J.Meeus, and C.Steyaert, "An Accurate Representation 
of the Motion of Pluto", Astronomy and Astrophysics, Vol 155, pages 323-325 (1986)). This 
should result in errors of less than 1" for the indicated period.



Moon

The position of the moon is computed from the ELP 2000-85 lunar theory (Chapront-Touzé 
and Chapront, 1988), which in turn is fitted to the DE200/LE200 numerical integration of 
the Jet Propulsion Laboratory (Standish, 1981).

Spot checks against the "Astronomical Almanac" again indicate that the mean error in the 
computed position of the Moon is about half an arc second, with peak errors around one arc
second.



Deep Sky Objects

The deep sky object database used by SkyMap is based on version 6 of the Saguaro 
Astronomy Club's deep sky database, and is used with their generous permission. The 
database contains approximately 10,600 objects of all types.
See also:
Deep Sky Object Catalogs
Dreyer Object Descriptions



Time Corrections

Because of the irregularities in the Earth's rotation, the theories of motion of astronomical 
bodies do not use Universal Time (GMT), but a uniform timescale called Terrestrial 
Dynamical Time (TDT).    SkyMap uses TDT internally for all its calculation of planetary 
positions, etc, but obviously the user specifies the time for which a map is required in UTC 
(or rather, in local time, which is converted to UTC).

The difference between TDT and UT is called "delta T", and currently has a value of 
approximately 1 minute.    It is currently increasing at a rate of somewhat less than 1 
second per year.    The problem is that the value of delta T can only be determined 
historically (typically by analyzing the motion of the Moon), and current and future values 
can only be estimated, whilst values for the distant past (before the advent of modern 
astronomy) are uncertain to the order of many minutes.

What this means in practice is that although the time of a total solar eclipse in the year 
1500BC could be computed to a precision of a fraction of a second in TDT, the actual time 
in UT that the eclipse occurs (hence the places on Earth from which it is visible) will be 
uncertain to within several minutes.

The "Astronomical Almanac" lists the values of delta T for every year from 1620 onwards 
(currently up to 1993), and provides estimates of its value for the current time.    SkyMap 
has all this data stored, and interpolates or extrapolates in this table to find values of delta 
T for dates between 1620 and 2000.

For dates beyond the year 2000, an estimate of delta T is made using the method of 
L V Morrison and F R Stephenson, "Sun and Planetary System" vol 96,73 eds. W Fricke, 
G Teleki, Reidel, Dordrecht (1982).

For dates prior to 1620, an estimate is made using the method of    F R Stephenson and 
M A Houlden, "Atlas of Historical Eclipse Maps", Cambridge University Press (1986).    They 
estimate the uncertainty to be 15 minutes at 1500BC.



Dedication

Respectfully dedicated to the memory of:

Francis R Scobee
Michael J Smith

Ellison S Onizuka
Judith A Resnick
Ronald E McNair
Gregory Jarvis

S Christa McAuliffe

the crew of Challenger flight STS 51-L, 28th January 1986
and to all who have lived - and died - for The Dream.

"Oh, I have slipped the surly bonds of earth,
And danced the skies on laughter-silvered wings;

Sunward I've climbed and joined the tumbling mirth
Of sun-split clouds -- and done a hundred things

You have not dreamed of -- wheeled and soared and swung
High in the sunlit silence. Hov'ring there,

I've chased the shouting wind along and flung
My eager craft through footless halls of air.

Up, up the long, delirious, burning blue
I've topped the wind-swept heights with easy grace,

Where never lark, or even eagle, flew;
And, while with silent, lifting mind I've trod
The high, untrespassed sanctity of space,

Put out my hand, and touched the face of God."

"High Flight"      John G Magee Jr



Deep Sky Object Catalogs

The deep sky object database contains objects from more than 80 different catalogs. Some 
of these are general catalogs, such as the Messier catalog, whilst others are specific to 
objects of a particular type, such as the Barnard catalog of dark nebulae.
Each catalog used in the database has a unique prefix, which must be entered accurately in
order to search for objects. These are as follows:

ADS Aitken Double Star catalog
AM Arp-Madore (globular clusters)
Antalova Antlova (open clusters)
Ap Apriamasvili (planetary nebulae)
Arp Halton Arp (interacting galaxies)
Bark Barkhatova (open clusters)
B Barnard (dark nebulae)
Basel Basel (open clusters)
BD Bonner Durchmusterung (stars)
Berk Berkeley (open clusters)
Be Bernes (dark nebulae)
Biur Biurakan (open clusters)
Blanco Blanco (open clusters)
Bochum Bochum (open clusters)
Ced Cederblad (bright nebulae)
Cr Collinder (open clusters)
Czernik Czernik (open clusters)
DDO David Dunlap Observatory (dwarf galaxies)
Do Dolidze (open clusters)
DoDz Dolidze-Dzimselejsvili (open clusters)
Dun Dunlop (globular clusters)
Fein Feinstein (open clusters)
Frolov Frolov (open clusters)
Gum Gum (bright nebulae)
H William Herschel
Haffner Haffner (open clusters)
Harvard Harvard (open clusters)
He Henize (planetary nebulae)
Hogg Hogg (open clusters)
HP Haute Provence (globular clusters)
Hu Humason (planetary nebulae)
IC 1st and 2nd Index Catalogs to the NGC
Isk Iskudarian (open clusters)
J Jonckheere (planetary nebulae)
K Kohoutek (planetary nebulae)
King King (open clusters)
Kr Krasnogorskaja (planetary nebulae)
Lac Lacaille (globular clusters)
Loden Loden (open clusters)
LDN Lynds (dark nebulae)
LyngaLynga (open clusters)
M Messier
MCG Morphological Catalog of Galaxies
Me Merrill (planetary nebulae)



Mrk Markarian (open clusters and galaxies)
Mel Melotte (open clusters)
M1 Minkowski (planetary nebulae)
M2 Minkowski (planetary nebulae)
M3 Minkowski (planetary nebulae)
M4 Minkowski (planetary nebulae)
NGC New General Catalog of Nebulae & Clusters.
Pal Palomar (globular clusters)
PC Peimbert and Costero (planetary nebulae)
Pismis Pismis (open clusters)
PK Perek & Kohoutek (planetary nebulae)
RCW Rodgers, Campbell, & Whiteoak (bright nebulae)
Roslund Roslund (open clusters)
Ru Ruprecht (open clusters)
Sa Sandqvist (dark nebulae)
Sher Sher (open clusters)
Sh Sharpless (bright nebulae)
SL Sandqvist & Lindroos (dark nebulae),

Shapley & Lindsay (clusters in LMC)
StephStephenson (open clusters)
Stock Stock (open clusters)
Ter Terzan (globular clusters)
Tombaugh Tombaugh (open clusters)
Ton Tonantzintla (globular clusters)
Tr Trumpler (open clusters)
UA Catalog of selected Non-UGC galaxies
UGC Uppsala General Catalog (galaxies)
UKS United Kingdom Schmidt (globular clusters)
Upgren Upgren (open clusters)
VV Vorontsov-Velyaminov (interacting galaxies)
vdB van den Bergh (open clusters, bright nebulae)
vdBH van den Bergh & Herbst (bright nebulae)
vdB-Ha van den Bergh-Hagen (open clusters)
Vy Vyssotsky (planetary nebulae)
Waterloo Waterloo (open clusters)
WestrWesterlund (open clusters)
Zw Zwicky (galaxies)



Dreyer Object Descriptions

The majority of objects in the deep sky database include the visual descriptions used by 
Johann Dreyer in his "New General Catalogue", published in 1888.    These descriptions are 
remarkable for their information content, but can be somewhat daunting at first.    For 
example, the Dreyer description of the globular cluster M3 in Canes Venatici is as follows:

GCL,EB,VL,VSMBM,*11

This can be translated as "Globular cluster, extremely bright, very large, very suddenly 
much brighter towards the middle, composed of 11th magnitude stars" - a pretty good 
description in only 19 characters!

Similarly the galaxy NGC 2863 in Hydra is described as:

CF,S,E,BET2*12,16

which means "considerably faint, small, elongated, between two stars of magnitude 12 and
16".

The description normally starts with a description of the object's brightness and size.    
Dreyer adopted the scale used for this from Sir John Herschel, and the order used may be 
confusing to modern observers; for example, is "considerably faint" brighter or fainter than 
merely "faint"?    The other possible source of confusion is that 19th century astronomers 
often called a faint star "small" and a bright star "large", so one always has to be careful to 
judge whether a description such as "pretty small" refers to size or brightness!

The scale used is as follows:

Brightness Size

EF Excessively faint ES Excessively small
VF Very faint VS Very small
F Faint S Small
CF Considerably faint CS Considerably small
PF Pretty faint PS Pretty small
PB Pretty bright PL Pretty large
CB Considerably bright CL Considerably large
B Bright L Large
VB Very bright VL Very large
EB Extremely bright EL  Excessively large

Next normally comes a description of object's general shape.    This lies on a scale ranging 
from "round" to "extremely extended", as follows:

Code Shape



R Round
VLE Very little extended
E Elliptic or oval
CE Considerably extended
PME Pretty much extended
ME Much extended
VME Very much extended
EE Extremely extended

By far the most cryptic part of the description, at first glance, is the group of letters giving 
what Sir John Herschel described as "the degree and rate of condensation".    A simple 
example is "GBM", meaning "gradually brighter towards the middle".    Looking, though, at 
NGC 4725, a galaxy in Coma Berenices, we find the dreadful looking "VSVMBMEBN"!    Even 
this mouthful, though, is fairly easily translated as "very suddenly very much brighter in the
middle, with an extremely bright nucleus".

When the descriptions give directions on the sky, the terms "preceding" and "following" are
used for west and easy respectively.    To see what is meant by this, picture the way an 
object drifts across the field of view of a telescope if the drive is switched off.    Use of these
terms is much more natural at the telescope eyepiece than the very confusing west and 
east, given the way that optical systems invert and/or reflect the field of view.

Quite often the notes speak of groups.    The "1st of 4" is the first member of a group of four
nebulae to drift across the field of view ie, the most western one, preceding all the others.    
All members of a group will have very nearly the same declination.

The complete list of abbreviations used in the Dreyer description of an object appears 
below:

Code Meaning

AB about
ALM almost
AM among
APP appended
ATT attached

B bright
B brighter (always coupled with another letter)
BET between
BF brighter toward following side
BIN binuclear
BN bright toward north side
BP brighter toward preceding side
BS brighter toward south side

C compressed
C considerably
CH chevelure
CL cluster
CO coarse, coarsely



COM cometic
CONT in contact
D double
D diameter
DEF defined
DIF diffused
DIFFIC difficult
DIST distance

E extended
E extremely, excessively
EE most extremely
ER easily resolvable
EXC excentric

F faint
F following

G gradually
GCL globular cluster of stars
GR group

I irregular
IF irregular figure
INV involved, involving

L large
L little (adv.), long (adj.)

M middle or in the middle
M much
MM mixed magnitudes
MN milky nebulosity

N nucleus or to a nucleus
N north
NEB nebula
NF north following
NP north preceding
NR near

P poor
P preceding
P pretty (before F, B, L, S) (size and brightness blocks)
PG pretty gradually
PLN planetary nebula
PM pretty much
PS pretty suddenly

QUAD quadrilateral
QUAR quartile

R round
R resolvable
RI rich



RR exactly round
RR partially resolved, some stars seen
RRR well, resolved, clearly consisting of stars

S small
S suddenly
S south
SC scattered
SEV several
SF south following
SH shaped
SM smaller
SP south preceding
ST stars
ST9 stars from the 9th magnitude downward
ST9...13 stars from 9th to 13th magnitude
STELLstellar
SUSP suspected

TRAP trapezium
TRI triangle, forms a triangle with
TRIN trinuclear

V very
VAR variable
VV very very,    an intensive of V

* a star (or stars)
*10 a star of 10th magnitude
** double star
*** triple star
() items questioned by Dreyer enclosed in parentheses
" arc seconds (two "not-equals" in published catalog)
' arc minutes (one "not-equals" in published catalog)



Measuring Angular Separation

It can be difficult to relate the distance between two objects shown on a map with their 
actual separation in the sky. To help with this, SkyMap provides an easy method of quickly 
finding the angular separation between any two objects. Just click the left mouse button 
over the two points, and a panel on the Status Bar displays their separation in degrees and 
minutes of arc.

Notes:

1. Make sure that you don't move the mouse between pressing the button and releasing
it, or SkyMap will think you are dragging a selection rectangle for a new map!

2. This method can be extended to measure the distances between a whole set of 
points; simply click on each point in turn, and the Status Bar panel will display the 
separation of the last two points clicked on.



Registered Versions of SkyMap

You may purchase two different versions of SkyMap:

Registered Version
The registered version of SkyMap provides the following enhancements over the shareware 
version:
- A much larger database of 88,000 stars to magnitude 8.5, compared with the 15,000 

stars supplied with the shareware version.
- A new deep sky object description database containing classification information, 

Dreyer object descriptions, and observing notes for all the deep sky objects.
- No "nag screens" when the program starts.
- Removal of the "unregistered version" message on printed output.

SkyMap/GSC
SkyMap/GSC provides all the facilities of the registered version and the following extras:
- The complete SAO catalog of 259,000 stars to magnitude 9.5.
- The ability to use the "Hubble Guide Star Catalog, version 1.1" (GSC) CD-ROM 

database of 19 million stars to below magnitude 14 for the whole sky. Note that the 
GSC database is not supplied with SkyMap/GSC, it is published by the Space 
Telescope Science Institute and must be purchased separately. SkyMap/GSC contains 
details of how to purchase it.

For details of the cost of the different versions of SkyMap, and information about how to 
order, please refer to the separate registration forms contained in the package.



The Area Map

The area map displays a detailed view of a small area of the sky on a grid of right ascension
and declination. Its main use is as a "finder chart" for observing a specific part of the sky.
For more information about drawing and using an area map, select one of the topics below:
Creating and Setting up a Area Map
Displaying Objects on a Map
Identifying Objects on a Map 
Measuring Angular Separation
Displaying the Track of a Moving Object
Searching for Objects on a Map
Saving the Map Settings

See also:
Using the Help System



Creating and Setting Up an Area Map

An area map can be created in one of two ways:

1. Select New Area Map from the File menu. A dialog will appear allowing you to set 
the position of the map centre and the field of view. Press OK to create the map - a 
new window will appear and the default map settings will be loaded. The time and 
date will be read from the computer's clock.

2. Click the right mouse button over the    point on a horizon map that you wish to 
appear at the centre of the area map, and select Area Map... from the menu which 
appears. A dialog will appear allowing you to alter the position of the map centre and 
to set the desired field of view. Press OK to create the map. A new area map window 
will appear and the default map settings will be loaded. The time, date, and 
observation location details will be copied from the horizon map.

Once the map has been created you may wish to alter the location of the observer, or the 
date and time for which the map is drawn:

Setting the Date and Time of Observation 
Setting the Location of the Observer
See also:
Saving the Map Settings



Displaying Objects on the Area Map

A wide variety of objects can be displayed on an area map. These include:

Stars
Planets
Comets
Asteroids
Deep sky objects (galaxies, star clusters, and nebulae)
Constellation boundaries, figures, and names
A grid of right ascension and declination lines

The objects which appear on the map are controlled in two ways:

1. The items on the Options menu set the display options for each type of object. For 
example, the Star Labels... item controls the way in which stars are labelled; the 
Comets... item allows the user to select which comets will be displayed. To get 
specific help on these options, select the item and then press F1.

2. The Show... item on the View menu (and the equivalent buttons on the tool bar) 
allows the user to select which items are shown on the map. A huge quantity of 
information is available, and having it all displayed at once would be very confusing. 
This menu item provides a rapid way to select exactly the desired items.

Shortcut:        



Saving the Area Map Settings

When all the area map options have been set up to your satisfaction they can be saved for 
use as the default settings for all subsequent area maps. To do this:

1. From the File menu select Save Defaults.... A dialog box will appear asking for 
confirmation of the operation.

2. Click on the Yes button, or just press Enter. The current map settings will then be 
saved.



Searching for Objects on an Area Map

To search for specific objects on an area map use the items on the Search menu.

See also:
Searching for a Planet
Searching for a Constellation
Searching for a Star by Proper Name
Searching for a Star by Bayer Letter
Searching for a Star by Flamsteed Number
Searching for a Star by SAO Number
Searching for a Deep Sky Object by Popular Name
Searching for a Deep Sky Object by Catalog Number
Searching for a Comet
Searching for an Asteroid



Displaying the Track of a Moving Object

One very useful feature of the Area Map is the ability to display the track of a moving 
object - ie a planet, comet, or asteroid. A "track" is simply a line showing the path taken by 
the object over a period of time. Points along the track, equally spaced in time, can be 
labelled with the date and/or the magnitude of the object. This is a very useful facility for 
printing a finder chart showing the position of a comet (or other object) over a long period 
of time.
To display the track of an object, carry out the following steps:
1. Set the time and date to that required for the first position on the track.
2. Draw a map showing the object, if necessary using the items on the Search menu to 

bring it into view.
3. Move the mouse pointer over the object, and click the right mouse button. A pop-up 

menu will be displayed.
4. Select the "Track of <object>..." item from the menu. The Track Object Dialog will be 

displayed.
5. Click OK to calculate and display the object track, or Cancel to abort the operation.

Notes:
1. The first position on the track will be calculated for the date and time currently 

selected for the map. Each subsequent position will add to this date and time the 
appropriate calculation interval. If, as is normally the case, the calculation interval is 
a whole number of days, you may wish to set the map time to midnight (0h) before 
calculating the track.

2. If the map shows moving objects other than the one for which a track is displayed, 
the positions of these other objects will obviously only be correct for the start of the 
track.

3. You can zoom in and out and scroll around a map while a track is displayed. The track
will be erased if anything is done which causes the map to be recalculated, such as 
changing the date, the observation location, or the field of view.



Displaying Pictures

One of the most exciting features of SkyMap is its ability to display photographic images.    
You can build up your own collection of pictures which, together with the maps, can really 
bring the sky to "life". A picture collection is also a good way to spend a cloudy night - here 
in England there are a lot of cloudy nights...
In order to display pictures, you really need a "SuperVGA" display capable of displaying 256
or more colours at once.    You can display pictures on a standard 16-colour VGA display, but
the results will probably be pretty horrible!
Pictures are displayed using the "SkyImage" application which accompanies SkyMap. For 
more information, refer to the following topics:

Picture Formats
Displaying Pictures Manually
Displaying Pictures Automatically
Obtaining Picture Files



Picture Formats

SkyMap can currently display picture files in the following formats:

1. GIF files.    GIF is probably the most popular of all image formats currently in use.    
The format was specifically devised to enable pictures to be easily transferred 
between different types of computer, and there are literally tens of thousands on 
pictures in GIF format available.    SkyMap will display files in either GIF87a or GIF89a 
format, and can handle both interlaced and non-interlaced images.    GIF files often 
contain a "comment extension block" - a text description of the picture; SkyImage 
allows this to be displayed, and copied to the clipboard, so it can be pasted into other
programs. The only restriction when using GIF files is that only the first image in a file
can currently be displayed.    GIF files for the PC normally have an extension of 
".GIF".

2. Windows "Bitmap" files.    These are "device independent bitmap" files created for use
with Microsoft Windows.    They normally have an extension of ".BMP" (for 
uncompressed images) or ".RLE" (for compressed images). Bitmap files are typically 
much larger than the equivalent GIF file, and are often found on BBSs for use as 
Windows "wallpaper" files.

3. NASA Planetary Data Systems (PDS) format. This is the file format used by NASA for 
pictures from spacecraft such as Voyager and Viking. The images normally have a 
resolution of 800x800 pixels, in 256 grey scales. Due to the large size of the files, CD-
ROM is the primary distribution medium for these images. There are three variants of 
the image format in common use:
Uncompressed full-resolution images, which normally have an extension of ".IMG".
Compressed full-resolution images, with an extension of ".IMQ".
Uncompressed "browse" images. These are uncompressed images containing only 
1/16th of the pixels of the full images, and are intended for rapid viewing. They 
normally have an extension of ".IBG".



Displaying Pictures Manually

Pictures are displayed using the separate "SkyImage" program supplied with the SkyMap 
package. This can be run in two different ways:
1. From the Tools menu, choose the Image Viewer... item. This will run the image 

viewer program, which by default is SkyImage. If you have your own image viewing 
program you would rather use, enter its name in the Global Preferences Dialog.

2. From the Windows Program Manager, double click on the SkyImage icon (a picture of 
a camera).

Once SkyImage is running, choose the Open... item from the File menu. A standard file 
selector will be displayed, allowing you to select a file from any available drive or directory. 
Press the OK button to display the image.



Displaying Pictures Automatically

SkyMap has the ability to load and display pictures of many types of object automatically.    
This can be done for all deep sky objects, comets and asteroids, as well as the planets, 
Moon, and Sun.    In order to use this feature of the program, carry out the following steps:

1. Find a nice picture of the required object in any supported image format.    You can 
use the "manual" method described above to look through pictures until you find one 
you would like to have as a "standard" picture for that particular object.

2. Copy the picture to the image directory specified in the Global Preferences Dialog , 
and rename the file to "OBJECT.EXT", where "OBJECT" is the name of the object, and 
".EXT" is the "standard" extension for the image format - ".GIF" for GIF files and 
".BMP" for bitmap files.
For planets, the name used should be one of the following:

SUN
MOON
MERCURY
VENUS
MARS
JUPITER
SATURN
URANUS
NEPTUNE
PLUTO
For deep sky objects, the name should be formed in the following way: take the 
primary catalog name of the object and remove all spaces. Next, replace any 
character which is not a letter or number by an underscore "_" character. If the 
resulting name is more than 8 characters long, take the last 8 characters of it. Finally,
add the extension for the type of file.
Eg: "NGC 5664" becomes "NGC5664"; "Sh2-1" becomes "SH2_1"; "PK 342+27.1" 
becomes "PK342_27_1", which is shortened to its last 8 characters to give 
"342_27_1".
For a comet, or an asteroid, the file can be called anything you wish, but it must still 
be in the image file directory. Edit the details of the comet using the Comet Selection 
Dialog and enter the file name in the Comet Orbit Dialog. Enter the filename of an 
asteroid image in the same way, using the Asteroid Selection Dialog.

3. Now, if you draw a map and click the right mouse button over an object for which a 
picture has been stored, you should find that a Picture of <object>... item appears 
on the resulting pop-up menu.    Selecting this item will run the image viewer and 
display the picture.

Notes:

When you click on a object, SkyMap will first of all look for a file with a ".GIF" extension, 
and then for a file with a ".BMP" extension.    If files with both extensions are present, the 
GIF file will be displayed.





Obtaining Picture Files

There are many sources from which picture files (particularly GIF images) suitable for use 
with SkyMap can be obtained.    Some of these are:

1. Commercial information services such as CompuServe.    An especially good source 
are the CompuServe "Astronomy" and "Space" forums (type "GO ASTROFORUM" or 
"GO SPACE" from any prompt), which currently has more than 1000 astronomy and 
space-related GIF files available.

2. Bulletin board systems, of which there are a vast and ever-changing number.    Some 
of these specialise in astronomy and carry a large number of GIF images.

3. Public domain and shareware software libraries.
4. If you have access to it, perhaps the best source of all are the vast resources of the 

Internet - a world-wide computer network.    Take a look, for example at the machine 
"explorer.arc.nasa.gov" via anonymous FTP.

5. Finally, if you get really stuck,    a collection of GIF images is available as an option for
registered users of SkyMap. Refer to the registration form for details.




